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ИНСТРУКЦИИ ПО БЕЗОПАСНОСТИ

Внимание: 

Показанные слева символы – это международные символы преду-
преждения о потенциальной опасности электрических продуктов. 
Знак молнии в треугольнике обозначает наличие в устройстве опас-
ных напряжений. Восклицательный знак в равностороннем треу-
гольнике означает необходимость обращения к руководству поль-
зователя. 
Эти символы предупреждают о том, что в устройстве нет деталей, ко-
торые могут быть отремонтированы пользователем. Не открывай-
те устройство. Не пытайтесь самостоятельно обслуживать устрой-
ство. Обслуживание устройства должно проводиться квалифициро-
ванным персоналом. Открывание корпуса приведет к лишению га-
рантийных обязательств. Не допускайте намокания устройства. При 
попадании жидкости внутрь устройства, немедленно отключите его 
от сети и обратитесь в сервисную службу. Для предотвращения по-
вреждений, отключите устройство от сети во время грозы. 

ИНСТРУКЦИИ ПО БЕЗОПАСНОСТИ

ПРИМЕЧАНИЯ ДЛЯ ПОЛЬЗОВАТЕЛЕЙ, УСТРОЙСТВА КОТОРЫХ ОБО-
РУДОВАНЫ ШНУРОМ ПИТАНИЯ. 
ВНИМАНИЕ: ДАННОЕ УСТРОЙСТВО ДОЛЖНО БЫТЬ ПОДКЛЮЧЕНО 
К СТЕННОЙ РОЗЕТКЕ С ЗАЗЕМЛЕНИЕМ.
Провода в кабеле имеют разные цвета в соответствии со следующей 
кодировкой:
Зеленый и желтый – Земля, Синий – нейтральный, Коричневый – под 
напряжением.
Поскольку цвета проводников в кабеле питания могут не соответ-
ствовать маркировке разъемов в вашей вилке, выполните следую-
щую процедуру:
• Зеленый и желтый провод должны быть подключены к разъему 

вилки с маркировкой в виде буквы Е, или окрашенных в зеленый 
или желтый цвета.

• Синий провод должен быть подключен к разъему с маркировкой 
N, или окрашенный в черный цвет.

• Коричневый провод должен быть подключен к разъему с марки-
ровкой L, или окрашенный в красный цвет.

В зависимости от источника питания, для данного оборудования мо-
жет потребоваться другой кабель, патронная штепсельная розетка 
или и то, и другое. При необходимости замены вилки, обратитесь в 
сервисную службу. Зелено/желтый провод должен быть подключен 
непосредственно к шасси устройства. 

CONDUCTOR WIRE COLOR
Normal Alt

L LIVE коричневый черный
N Нейтраль синий: белый
E Земля зелено/желтый Зеленый

Внимание: Если земля отключена, при некоторых неисправностях в 
устройстве или системе, к которой оно подключено, может появить-
ся напряжение между корпусом и землей. В этом случае, одновре-
менное прикосновение к корпусу и земле может привести к серьез-
ным повреждениям или смерти.

Предупреждение. 

Внимательно прочитайте следующее:

СОХРАНИТЕ ЭТИ ИНСТРУКЦИИ. 

ВНИМАТЕЛЬНО ОТНЕСИТЕСЬ КО ВСЕМ ПРЕДУПРЕЖДЕНИ-
ЯМ. 

СЛЕДУЙТЕ УКАЗАНИЯМ, ДАВАЕМЫМ В ИНСТРУКЦИЯХ. 

УСТРОЙСТВО НЕ ДОЛЖНО ЭКСПЛУАТИРОВАТЬСЯ ПРИ ПО-
ПАДАНИИ НА НЕГО ЖИДКОСТИ. НЕЛЬЗЯ УСТАНАВЛИВАТЬ 
НА УСТРОЙСТВО ЕМКОСТИ С ЖИДКОСТЬЮ.

ЧИСТИТЕ УСТРОЙСТВО ТОЛЬКО СУХОЙ ТРЯПОЧКОЙ. 

НЕ БЛОКИРУЙТЕ ВЕНТИЛЯЦИОННЫЕ ОТВЕРСТИЯ. УСТА-
НОВКА ДОЛЖНА ВЫПОЛНЯТЬСЯ В СООТВЕТСТВИИ С ИН-
СТРУКЦИЯМИ ПРОИЗВОДИТЕЛЯ.

НЕ УСТАНАВЛИВАЙТЕ УСТРОЙСТВО ВБЛИЗИ ИСТОЧНИКОВ 
ТЕПЛА: РАДИАТОРОВ, БАТАРЕЙ, ПЕЧЕК ИЛИ ДРУГОЙ АППА-
РАТУРЫ (ВКЛЮЧАЯ УСИЛИТЕЛИ) ИЗЛУЧАЮЩЕЙ ТЕПЛО.  

ИСПОЛЬЗУЙТЕ ТОЛЬКО ТЕ АКСЕССУАРЫ, КОТОРЫЕ РЕКО-
МЕНДОВАНЫ ПРОИЗВОДИТЕЛЕМ. 

ВО ВРЕМЯ ГРОЗЫ ОТКЛЮЧАЙТЕ ОБОРУДОВАНИЕ. ТАКЖЕ 
ОТКЛЮЧАЙТЕ В ТОМ СЛУЧАЕ, ЕСЛИ ОБОРУДОВАНИЕ НЕ 
ИСПОЛЬЗУЕТСЯ В ТЕЧЕНИЕ ДЛИТЕЛЬНОГО ВРЕМЕНИ. 

В целях безопасности используйте поляризованную вилку 
или вилку с заземлением. В поляризованной вилке имеется 
два контакта, один из которых шире другого. Вилка с зазем-
лением имеет три контакт, один из которых – заземляющий. 
Широкий штырь или заземляющий используются для обе-
спечения дополнительной безопасности. Если прилагаемая 
вилка не подходит к вашей розетке, обратитесь к электрику 
для замены на соответствующую. 

Обеспечьте защиту сетевого шнура от случайного наступа-
ния или сжатия, особенно в районе вилки и в точке выхо-
да из аппаратуры. 

Используйте оборудование только вместе с тележкой, под-
ставкой, треногой или столом, рекомендованным произво-
дителем, или поставляемым вместе с оборудованием. При 
использовании тележки, будьте внимательны при ее пере-
мещении вместе с аппаратурой во избежание опрокиды-
вания. 

Обслуживание устройства должно проводиться квалифи-
цированным персоналом. Обращайтесь в сервисный центр 
в случае какого-либо повреждения оборудования, сетево-
го шнура, вилки, попадании внутрь жидкости или посторон-
них предметов, при эксплуатации оборудования под до-
ждем или в условиях повышенной влажности, если оно не 
работает нормальное, или упало. 

Переключатель включения/выключения питания: Переклю-
чатель питания, используемый в данной части оборудова-
ния, не выполняет полное отключение от сети.

ОТКЛЮЧЕНИЕ ОТ СЕТИ: Доступ к вилке должен быть сво-
бодным. Для рэковой установки или инсталляций, где вил-
ка недоступна, в стойке или здании должен быть установ-
лен двухпозиционный переключатель с разделением меж-
ду контактами как минимум 3 мм. 

ДЛЯ УСТРОЙСТВ С ВНЕШНИМ ДЕРЖАТЕЛЕМ ПРЕДОХРА-
НИТЕЛЯ: Замена предохранителя осуществляется только на 
предохранитель с таким же номиналом.

МНОГОКАНАЛЬНОЕ НАПРЯЖЕНИЕ: В зависимости от ис-
точника питания, для данного оборудования может потре-
боваться другой кабель, патронная штепсельная розет-
ка или и то, и другое. Подключайте данное оборудование 
только к источнику питания, указанному на тыльной панели 
оборудования. Для уменьшения риска возгорания или уда-
ра электрическим током, обслуживание должно выполнять-
ся квалифицированным специалистом. 

При подключении к источнику питания 240 В, необходимо 
использовать подходящий сертифицированный CSA/JL ка-
бель питания.



Заявление о совместимости
Имя производителя: Lexicon Professional

Адрес производителя: 8760 S. Sandy Parkway 

  Sandy, Utah 84070, USA

заявляет, что данный продукт:

Наименование продукта Lexicon IO 22

Опция продукта: все (требуется адаптер питания класса II

  соответствующие требованиям EN60065, EN60742, или аналогичный.)

удовлетворяет следующим спецификациям продукта:

Безопасность: IEC 60065 -01+Amd 1

EMC: EN 55022:2006

  EN 55024:1998 

  FCC Part 15

Дополнительная информация

Данный продукт соответствует требованиям: Директива по низковольтным прибо-

рам 2006/95/EC Директива ЕМС 2004/108/EC. Директива RoHS (об ограничении ис-

пользования некоторых вредных веществ в электрическом и электронном оборудо-

вании) 2002/95/EC Директива ЕС об утилизации электрического и электронного обо-

рудования 2002/96/EC

В соответствии с требованиями директивы 2005/32/EC и законодательных актов ЕС 

1275/2008 от 17 декабря 2008, этот продукт разработан, произведен и классифици-

рован как профессиональное аудио оборудование и таким образом освобожден от 

этой директивы. 

С учетом директивы 2005/32/EC и законодательного акта ЕЭС 278/2009 от 6 апреля 

2009, этот норматив применяется к внешним источникам питания класса А (одиноч-

ный выход). Внешний источник питания, используемый с данным продуктом – это 

источник питания с несколькими выходами и, таким образом, он освобождается от 

обязанности соблюдения данной директивы. 

Roger Johnsen Director, Engineering Signal Processing 8760 S. Sandy Parkway Sandy, Utah 

84070, USA Date: Февраль 23, 2011

Контакты в Европе: Контактные данные для Европы: Региональная служба продаж Lexicon и 

сервисный центр или 

Harman Signal Processing

8760 South Sandy Parkway

Sandy, Utah

84070 USA

Телефон: (801) 566-8800

Факс: (801) 568-7583

Важные инструкции по безопасности 

ЭЛЕКТРОМАГНИТНАЯ 
СОВМЕСТИМОСТЬ

Данное устройство удовлетворяет части 15 правил FCC и спецификациям продукта, указанным 

в заявлении о соответствии. Работа удовлетворяет следующим двум условиям: 

• устройство не приводит к появлению вредного излучения, и 

• данное устройство может принимать любые излучения, включая помехи, которые могут 

привести к нежелательной работе. 

Не эксплуатируйте устройство в сильных электромагнитных полях.

• используйте только экранированные непересекающиеся кабели.

Во время утилизации данного устройства, не выкидывайте его вместе с бытовым мусором. 

Имеется специальная система для сбора использованных электронных продуктов в соот-

ветствии с местными законами, 

Частные домовладельцы в 25 странах, членах ЕС, в Швейцарии и Норвегии могут возвращать свои ис-

пользованные электронные в специализированные пункты сбора

Если вы живете в неупомянутой выше стране, обращайтесь к местной администрации для уточнения 

правильного способа утилизации. Это позволит предотвратить негативное воздействие на окружаю-

щую среду.



Информация по обслуживанию
При необходимости технической поддержки, обращайтесь в сервисный центр Lexicon® 
Professional Customer Service. Приготовьтесь точно описать свою проблему. Посмо-
трите серийный номер устройства (находится на этикетке на дне IO-22). Если вы еще 
не нашли время, чтобы заполнить и отослать регистрационную карту, сделайте следу-
ющее:

Перед возвратом продукта на завод для обслуживания, рекомендуется обратиться к 
руководству пользователя. Удостоверьтесь в правильности выполнения всех этапов 
установки и работы. При невозможности решения проблемы, обращайтесь в Отдел 
обслуживания клиентов по телефону (801) 568 - 7660 для консультации. При необхо-
димости возврата продукта на завод для обслуживания, необходимо связаться со служ-
бой работы с покупателями для получения номера разрешения на возврат. Без это-
го номера, прием, возвращенных на завод продуктов, производится не будет. Смотри-
те информацию по гарантии на следующей странице. После истечения гарантийного 
срока, завод выполнит замену деталей и ремонт за разумную плату. Во всех случаях, вы 
несете расходы по транспортировке на завод. Если устройство находится на гарантии, 
Lexicon Profwssional возмещает расходы по транспортировке. 

По возможности используйте оригинальный упаковочный материал. На упаковке на-
пишите имя грузоотправителя и следующую информацию красным цветом. ОСТО-
РОЖНО, ХРУПКОЕ!

Тщательно закрепите упаковку. Оплатите пересылку. Не отправляйте устройство в ви-
де посылки. 



Содержание

ВВЕДЕНИЕ ................................................................................................................................................... 1
Основные характеристики ...........................................................................................................1
Распаковка настольного интерфейса IO 22 .............................................................................2
Комплектация ...................................................................................................................................2
Системные требования ..................................................................................................................2

ПЕРЕДНЯЯ ПАНЕЛЬ ................................................................................................................................... 3

ЗАДНЯЯ И БОКОВАЯ ПАНЕЛИ ................................................................................................................. 5

ПОДКЛЮЧЕНИЕ К IO 22 .............................................................................................................................. 7
Микрофоны .......................................................................................................................................7
Источники с линейным уровнем сигнала ................................................................................7
Инструменты  ...................................................................................................................................7
Компьютер/цифровая рабочая станция (DAW) ...................................................................7
Наушники ..........................................................................................................................................7
Мониторные динамики .................................................................................................................7
Пример подключений ....................................................................................................................8

ПРИМЕР ПРОЕКТА IO 22 – ЗАПИСЬ ГИТАРЫ ......................................................................................... 9
Установка драйверов, управляющего программного обеспечения и Cubase® LE. .......9
Активизация Cubase LE ................................................................................................................9
Пример подключений ................................................................................................................. 10
Подключение гитары .................................................................................................................. 11
Подключение компьютера ......................................................................................................... 13
Прослушивание входа Guitar (Прямой) ................................................................................ 13
Настройка Cubase® LE для работы с IO 22 
(Windows®) ...................................................................................................................................... 14
Настройка Cubase® LE для работы с IO 22 
(Мас®) ................................................................................................................................................ 15
Запись трека в программе Cubase® LE .................................................................................... 16
Создание нового проекта .......................................................................................................... 16
Начните запись .............................................................................................................................. 17
Прослушивание записи .............................................................................................................. 17
Сведение аудио .............................................................................................................................. 18
Опции и основные функции в Cubase LE ............................................................................. 18
Использование Pantheon II Reverb в Cubase LE ................................................................. 18

БЛОК СХЕМА .............................................................................................................................................. 19

ТЕХНИЧЕСКИЕ ХАРАКТЕРИСТИКИ ........................................................................................................ 21





1

Введение

Поздравляем Вас с приобретением настольного аудиоинтерфейса Lexicon IO-22

Эргономичный дизайн интерфейса IO-22 позволяет расположить его между клавиа-
турой и монитором. Таким образом, всё управление и мониторинг входных сигналов 
всегда находится прямо перед глазами и под пальцами звукорежиссёра.

Все компоненты устройств серии IO-22 высочайшего качества, что гарантирует полу-
чение записи, соответствующей стандартам Lexicon. Каждый интерфейс оборудован 
новым микрофонным предусилителем dbx* 60В на всех аналоговых выходах. Эти пред-
усилители, работающие от источника питания 60В гарантируют стабильную работу и 
великолепное качество записи во всем динамическом диапазоне. Аналогово-цифровые 
и цифро-аналоговые преобразователи 24 бит/96 кГц обеспечивают профессиональное 
звучание записи. 

Как известно, Lexicon - это синоним понятия «лучший ревербератор в мире». Новый 
плагин Pantheon II предлагает шесть типов ревербераторов с 16 регулируемыми пара-
метрами, а также 35 заводских пресетов для вокала и инструментов. Насыщенные и 
богатые реверберации Lexicon сделают ваш микс и музыку еще лучше.

Основные характеристики
• Новые микрофонные предусилители dbx* с ультранизким уровнем шума.
• 2 аналоговых микрофонно/линейных входов (combi-jack)
• 1 инструментальный вход на боковой панели.
• 2 аналоговых выхода TRS
• 1 выход наушников со специализированным регулятором громкости. 
• MIDI in и out
• USB 2.0 аудиоинтерфейс 
• частота дискретизации от 44.1 до 96 кГц, разрядность 24 бит.
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Распаковка настольного интерфейса IO 22
Каждый интерфейс IO22 упакован в одну коробку, в которой находится устройство 
IO22 и DVD диск с программным обеспечением для операционных систем Windows 
и Macintosh. После распаковки сохраните упаковочные материалы для последующей 
транспортировки устройства. Тщательно проверьте интерфейс IO-22 и упаковочные 
материалы на предмет повреждения. При обнаружении повреждений необходимо 
предъявить претензии поставщику. 

Комплектация:

• Настольный интерфейс IO 22
• Установочный диск DVD с драйверами, руководством, плагинами Lexicon 

Pantheon II reverb, XILS3 SE, программным обеспечением записи Cubase LE, и 
ToonTrack® EZDrummer Lite для Mac® и Windows®

• USB кабель
• Гарантийная карта Lexicon Professional 
• Источник питания

Примечание: Полное руководство по работе с Cubase LE находится на диске с ПО 

Системные требования
Для обеспечения работы ПО аудиозаписи необходимо наличие мощного компьютера 
с соответствующей ОС, процессором и памятью. 

 Продаваемые в настоящее время компьютеры, в основном удовлетворяют этим тре-
бованиям. Они также могут быть улучшены  для обеспечения совместимости с интер-
фейсом IO22. При работе с такими системами надо помнить о том, что добавление до-
полнительной памяти RAM позволит выполнить обработку лучше и значительно улуч-
шить характеристики. 

Windows® Vista, XP, 7 (Минимальные системные требования)

• Многоядерный процессор
• 1GB RAM
• Разрешение дисплея 1024 x 768 пикселов
• Привод DVD-ROM 
• Доступ в Интернет, необходимый для активизации лицензии программного обе-

спечения.

Мас (Минимальные системные требования)

• Процессор Intel® 
• 1 GB RAM
• Версия OS X 10.4.9 или выше
• Разрешение дисплея 1024 x 768 пикселов
• Привод DVD-ROM 
• Доступ в Интернет, необходимый для активизации лицензии программного обе-

спечения.

Примечание: Программа Adobe Reader необходимо для просмотра документов в фор-
мате pdf на DVD
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1 2

3 4 5 6 7 8 9 10 11

Передняя панель

1. Индикаторы уровня входного сигнала

Показывают уровень сигнала каждого входа в виде оставшегося запаса по уровня до начала ограничения. 
Значения:
Красный Ограничение
желтый –3dB
Зеленый –6dB
Зеленый –9dB
Зеленый –12dB
Зеленый –18dB
Зеленый –24dB
Зеленый –30dB

2. Индикаторы уровня выходного сигнала

Показывают уровень сигнала каждого выхода в виде оставшегося запаса по уровню до начала ограничения. 
Значения:
Красный Ограничение
желтый –3dB
Зеленый –6dB
Зеленый –9dB
Зеленый –12dB
Зеленый –18dB
Зеленый –24dB
Зеленый –30dB

3. Регулятор уровня сигнала в наушниках (Phones) 

Регулировка уровня выходного сигнала на наушники.

4. Регулятор усиления MIc/LIne/InSt 1 

Регулировка уровня усиления входного сигнала для входoв Mic/Line1 или Instrument 1. 
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5. Индикатор инструмента 

Загорается при подключении ¼ дюймовой вилки в гнездо Instrument на правой боко-
вой панели. 

6. Кнопка Stereo и индикатор Stereo.

Кнопка переключения между режимом стерео и моно для входа Mic/Line1 (или ин-
струментального входа) и входа Mic/Line 2. (При включении режима стерео индика-
тор горит). 

В режиме Stereo (горит индикатор стерео), входные сигналы входов Instrument и Mic/
Line1 посылаются на левый основной выхода, а входной сигнал Mic/Line2 посылается 
на правый основной выход.

В режиме Mono (индикатор Stereo выключен), каждая пара входных сигналов микши-
руется и посылается на левый и правый основные выходы как монофонический сиг-
нал. Каждая пара включает сигналы со входов Instrument или Mic/Line 1 и Mic Line 2

Это не влияет на сигнал, посылаемый на компьютер.

7. Индикатор 48v 

Загорается при активизации фантомного питания для входов Mic/Line 1 и 2. Фантом-
ное питание может быть включено на комби-разъеме с помощью кнопок 48V на зад-
ней панели. Для работы динамических микрофонов фантомное питание не требуется. 
Фантомное питание требуется для работы большинства конденсаторных микрофонов. 
Если вы не уверены в необходимости подачи фантомного питания для работы микро-
фонов, необходимо обратиться к документации или к производителю.

8. Регулятор усиления MIc/LIne 2 

Регулировка уровня усиления входного сигнала для входoв Mic/Line2. 

9. Регулятор уровня выходного сигнала

Регулировка уровня сигнала на левом и правом основном выходе. 

10. Регулятор MonItor MIx 

Интерфейс IO 22 позволяет напрямую прослушать аналоговые входные сигналы во 
время выполнения записи без необходимости регулировки уровней в программном 
обеспечении и до момента задержки, возникающей в результате работы цифровых 
конвертеров и латентности компьютерной записи. Аналоговый мониторинг с нуле-
вой латентностью регулируется ручкой Monitor Mix, которая может быть использова-
на для регулировки микса между концертными аналоговыми входами (“Direct”) и лю-
быми звуками, поступающими назад с компьютера через USB (“Playback”)/ Для про-
слушивания входных сигналов только с концертного источника, подключенного к IO 
22, поверните регулятор MIX полностью влево в положение Direct. Для прослушива-
ния только микса с компьютера, поверните регулятор Mix полностью вправо в поло-
жение Playback. Выходной сигнал с Monitor Mix маршрутизируется на выходы Main и 
Headphones. 

11. Индикатор USB

Загорается при определении USB подключения. 
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1 32 4 5 6 7 8 9

Задняя и боковая панели

1. Инструментальный вход (Instrument)

К этому небалансному входу подключается 1/4 дюймовый разъем. Вход поддерживает источники с уровнем сигнала 
Instrument (включая гитары) Обратите внимание, что при подключении входа Instrument, вход Mic/Line 1 отключен.

2. Переключатель питания:

Включение /выключение питания IO 22

3. Разъем питания

Используйте только прилагаемый источник питания (для Уточнения смотрите раздел «Технические характеристики»)

4. USB порт 

USB порт используется для подключения IO 22 к компьютеру. Прилагается стандартный USB-кабель. IO 22 совместим 
только с USB 2.0. 

5. MIDI in и out

MIDI-разъемы обеспечивают MIDI-вход и MIDI-выход с компьютера. Эти разъемы используются для подключения 
MIDI клавиатур, звуковых модулей и внешних контроллеров.

6. Выходы MAIN 

К этим выходам могут быть подключены балансные TRS или небалансные TS 1/4 разъемы. Эти выходы могут быть 
подключены к микшерной панели, усилителю мощности, активным студийным мониторам, записывающему устрой-
ству или другому линейному входу. Для подключений используйте балансные кабели. При подключении к другому ба-
лансному оборудованию, используйте балансные кабели для получения наилучших характеристик. 

7. Входы MIc/LIne 1–2

К этим балансным входам подключаются XLR или ¼'' разъемы. Они обеспечивают поддержку источников с сигналами 
линейного и микрофонного уровня. Обратите внимание, что при подключении входа Instrument, вход Mic/Line 1 от-
ключен.
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8. Кнопка 48v PhantoM Power - MIc/LIne 1 anD MIc/LIne 2

Включение подачи фантомного питания на входы Mic/Line 1 и Mic/Line 2. При вклю-
чении, на передней панели загорается индикатор +48V между регуляторами усиле-
ния Mic/Line/Inst 1 и 2. Для работы динамических микрофонов фантомное питание 
не требуется. Фантомное питание требуется для работы большинства конденсаторных 
микрофонов. Если вы не уверены в необходимости подачи фантомного питания для 
работы микрофонов, необходимо обратиться к документации или к производителю. 
При подключении к разъемам Mic In любого источника с линейным уровнем сигнала, 
этот переключатель должен быть выключен. 

9. Разъем  наушников (Headphones) 

К выходу Headphones могут быть подключены стереофонические наушники с ¼`` сте-
рео вилкой. Сигнал на выходе такой же, как и сигнал, посылаемые на выходы Main, но 
имеет независимый регулятор уровня. 
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Подключение к IO 22

Микрофоны
Подключите XLR кабель от микрофона к нужному входу Mic/Inst на задней панели IO 
22.

Если для работы микрофона требуется фантомное питание, необходимо вначале под-
ключить микрофон и затем нажать кнопку +48 V для соответствующего входа на зад-
ней панели. Если для работы микрофона фантомного питания не требуется, кнопку 
включать не надо. 

Примечание: Некоторые микрофоны могут быть повреждены при подключении фан-
томного питания +48В. Перед включением фантомного питания необходимо обра-
титься к документации микрофона.

Источники с линейным уровнем сигнала
Источники с линейным уровнем сигнала включают клавишные инструменты, ритм-
машины, CD-плееры и внешние микрофонные предусилители, процессоры эффектов 
и гитарные процессоры. Подключите кабель 1/4'' TS (небалансный) или TRS (баланс-
ный) напрямую от линейного источника к нужному входу Mic/Inst на задней панели 
IO 22. Для получения лучшего шумоподавления используйте балансные кабели при 
подключении к балансным линейным источникам. 

Инструменты 
Разъем Instrument на задней боковой панели предназначен для приема сигналов с му-
зыкальных инструментов, например: электрические гитары и бас-гитары. Подключите 
стандартный небалансный ¼'' TS (instrument) кабель напрямую от инструмента к вхо-
ду Instrument на правой боковой панели IO 22. Обратите внимание, что при подклю-
чении входа Instrument, вход Mic/Line 1 отключается. 

Компьютер/цифровая рабочая станция (DAW)
Подключите USB порт компьютера к USB порту на задней панели IO 22 с помощью 
стандартного USB-кабеля (прилагается).

Наушники
Подключите наушники к разъему Headphones, расположенному на левой боковой па-
нели. Для подключения к разъему Headphones используются ¼`` TRS разъемы. Отре-
гулируйте громкость наушников с помощью ручки Phones Level.

Мониторные динамики
С помощью ¼'' кабелей подключите разъемы L/R MAIN Output на задней панели к 
соответствующим входам на микшере, усилителе мощности или активным мониторам. 
Отрегулируйте уровень громкости выходного сигнала с помощью ручки Output Level. 
При подключении к другому балансному оборудованию, используйте балансные кабе-
ли для получения наилучших характеристик. 
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Пример подключений

PC или Мас

Микрофон

Монитор

USB кабель

Инструмент

¼’’ кабель инструмента

Клавиатура

Активные динамики

Наушники

Выход наушников

MIDI OutMIDI In
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eLicense Number
(20 characters)

Activation code
(32 characters)

Пример проекта IO 22 – запись гитары

Просмотрите шаги данного примера для начала работы с использованием 
IO 22 и ознакомьтесь с ними. В данном примере используется ПО Cubase® 
LE, но интерфейс IO 22 работает с различными приложениями DAW.

Установка драйверов, управляющего программного 
обеспечения и Cubase® LE.
1. Вставьте диск DVD в привод DVD-ROM. Автоматически будет запу-

щен инсталлятор. 
 Если инсталлятор не запускается автоматически, запустите его вруч-

ную. Для этого откройте соответствующий файл на диске DVD. 
 Mac®: Open Me
 Windows®: InstallationMenu.exe
2. После того, как инсталлятор будет открыт, выполните указания на 

экране для установки нужного программного обеспечения. 
 Примечание: Для работы IO 22 c Cubase® LE необходимо установить 

драйвера IO 22. Необходимо также установить ПО Cubase LE, следуя 
шагам в примере на следующих страницах. 

 Более свежие версии драйверов IO 22 могут быть также загружены с 
сайта www.lexiconpro. Com.

Активизация Cubase LE
1. Установите Cubase LE
2. Запустите Cubase LE и нажмите ‘Register Now’ или перейдите на сайт 

www.steinberg.net/ en/mysteinberg
3. Создайте аккаунт MySteinberg (следуйте инструкциям на экране ) и за-

регистрируйтесь на MySteinberg.
4. Щелкните на версии Cubase LE в разделе Activation & Reactivation и 

затем щелкните ‘More’ (Далее) в разделе Permanent Activation.
5. Введите номер лицензии программного обеспечения (Sel Nr.). Номер 

лицензии можно найти в центре управления лицензиями в следующих 
местах: 

 Windows: Пуск > Все программы > Syncrosoft  > eLicenser Control 
Center.

 Mac: Applications > eLicenser Control Center.
6. Выберите Lexicon в поле Hardware Manufacturer и щелкните 

‘RequestActivation Code’.
7. Скопируйте код активизации.
8. Перейдите в окно eLicenser Control Center (из шага 5) и щелкните 

‘Enter Activation Code’.
9. Введите код активизации, щелкните “Continue” и щелкните ‘Download 

License’.
10. После загрузки лицензии нажмите “Click”.



10

 

Установка Windows® Audio и MIDI (Опционально)
После установки драйверов и управляющего программного обеспечения, Windows может ав-
томатически выбрать их в качестве аудио и MIDI выходов по умолчанию. Это означает, что зву-
ки Windows будут выводиться не через звуковую карту компьютера, а через IO 22. После завер-
шения работы с интерфейсом необходимо восстановить прежние настройки компьютера. 
1. Выберите Пуск >Панель управления >Звуки и аудиоустройства (XP) или Обору-

дование и звук (Vista/7).
2. Выберите закладку Аудио (XP) или Управление аудиоустройствами (Vista/7).
3. В разделе Воспроизведение звука используемое по умолчанию устройство (XP), 

или Воспроизведение (Vista/7), проверьте, чтобы в качестве устройства по умол-
чанию была выбрана звуковая карта компьютера.

4. В разделе Запись звука >Используемое по умолчанию устройство (XP), или За-
пись (Vista/7), проверьте, чтобы в качестве устройства по умолчанию была выбра-
на звуковая карта компьютера.

5. В разделе Воспроизведение MIDI >Используемое по умолчанию устройство, от-
кройте ниспадающее меню и проверьте, чтобы в качестве устройства по умолчанию 
была выбрана Microsoft  GS Wavetable Synth (только для XP).

Пример подключений

PC или Мас

USB кабель

Монитор

Инструмент

¼’’ кабель инструмента
Наушники

Выход наушников
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Подключение гитары
1. Поверните регулятор Mic/Line/Inst 1 полностью вниз.

Регулятор MIc/LIne/InSt

2. Подключите гитару ко входу Instrument 1, расположенному на правой боковой панели.

Вход Instrument 1
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Подключение наушников
1. Поверните регулятор Phones 1 полностью вниз.

Регулятор Phones 1

2. Подключите наушники к разъему Phones 1, расположенному на левой боковой 
панели.

Вход Phones 1 
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Подключение компьютера 

Подключите USB порт компьютера к USB порту на задней панели IO 22 с помощью 
стандартного USB-кабеля (прилагается).

PC или Мас

Монитор

USB кабель

Прослушивание входа Guitar (Прямой)
1. Оденьте наушники 
2. Установите регулятор микса мониторинга в положение 12:00. В этом случае будет 

прослушиваться равная смесь сигналов, поступающих на IO 22, а также сигналов, 
поступающих с Cubase. 

3. Сыграйте на гитаре и поднимите регулятор уровня входного линейного сигнала 1 
так, чтобы увидеть сигнал на индикаторе входа 1. 

4. Постепенно поднимите регулятор Phones 1 до тех пор, пока не будет получен ком-
фортный уровень для прослушивания.
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Настройка Cubase® LE для работы с IO 22 
(Windows®)
1. Удостоверьтесь, что прилагаемый USB кабель подключен к компьютеру и к IO 22, и 

интерфейс IO 22 включен.

2. Запустите Cubase® LE (из меню Пуск - Lexicon®).

3. При появлении предупреждения, показанного ниже, нажмите ОК. 

4. После запуска программы Cubase LE, перейдите Devices>Device Setup.

5. В разделе Устройства, щелкните на VST Audio System и выберите Lexicon IO 22 из 
ниспадающего меню ASIO Driver, если эта опция еще не была выбрана. Щелкни-
те на Switch для включения драйвера и затем щелкните ОК в диалоговом окне уста-
новки устройства (Device Setup) Теперь вы готовы начать запись с использованием 
IO 22 и Cubase LE 

Примечание: В большинстве случаев, можно улучшить характеристики. Для этого не-
обходимо выбрать более высокую установку латентности в ниспадающем меню System 
Performance на панели управления ASIO (Devices > Device Setup > Lexicon IO 22 > 
Control Panel > ASIO).
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Настройка Cubase® LE для работы с IO 22 
(Мас®)
1. Удостоверьтесь, что прилагаемый USB кабель подключен к компьютеру и к IO 22, 

Микшер открыт, и интерфейс IO 22 включен.
2. Откройте Cubase LE (Расположен в папке Приложения), и перейдите к 

Devices>Device Setup как показано ниже.

3. Щелкните на VST Audio System и выберите Lexicon IO 22 в качестве ASIO Driver, 
если эта опция еще не была выбрана. 

4. Cubase® LE сделает запрос на включение драйвера Выберите Switch а затем OK.

5. Удостоверьтесь, что драйвер загружен. Для этого щелкните Reset. Нажмите ОК.

Только для пользователей Mac® OS 10.4.x: После выбора Lexicon IO 22 в качестве 
ASIO Driver, необходимо удостовериться, что входы устройства активны. Для этого 
выполните следующие шаги:
1. Выберите на панели меню Device>VST Connections.
2. При появлении панели VST Connections, щелкните на закладке Inputs.
3. В рамке в колонке Audio Device может появиться надпись “Not Connected” (Не 

подключено) В этом случае, щелкните на этой рамке и выберите Lexicon IO 22 для 
включения входов IO 22 

4. Закройте окно VST Connections.

Теперь вы готовы начать запись с помощью ПО Cubase LE. Смотрите следующий 
раздел.
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Запись трека в программе Cubase® LE
Создание нового проекта
1. В программе Cubase, нажмите File > New Project (Файл – новый проект). Откроет-

ся диалоговое окно New Project.
2. Выберите Lexicon IO 22 Mono In и щелкните OK.
3. Выберите папку проекта и щелкните Choose (Выбрать)
4. Для добавления монофонического трека щелкните Project -> Add Track -> Audio 

(Проект - добавить трек – Аудио). Выберите конфигурацию Mono и нажмите ОК.
5. В окне Audio I, кнопка включения записи  должна быть красной. Если нет, щел-

кните на ней, чтобы она стала красной.

6. В окне Audio I, щелкните на кнопке мониторинга входа  так, чтобы она не 
горела.
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Начните запись
1. Щелкните на кнопке Record (Запись) в Cubase® LE’s Transport control.

Кнопка записи

2. Сыграйте на гитаре
3. После завершения записи нажмите кнопку Stop (Остановка)

Кнопка STOP 

Прослушивание записи
1. В программе Cubase, щелкните кнопку Go to Zero (Переход к нулю).

Кнопка Go to Zero 

2. Поверните регулятор Phones полностью вниз.
3. Оденьте наушники 
4. В программе Cubase, щелкните кнопку Play (Воспроизведение).

Кнопка PLAY (ВОСПРОИЗВЕДЕНИЕ)

5. НА интерфейсе IO 22, Постепенно поднимите регулятор Phones до тех пор, пока 
не будет получен комфортный уровень для прослушивания.

После добавления трека в проект Cubase, поле маршрутизации входного сигнала, по 
умолчанию будет установлено на IO 22 In1. Однако, при подключении инструментов к 
другим входам на IO 22, необходимо изменить маршрутизацию входного сигнала для 
записываемого трека. В таблице ниже показано соответствие меток маршрутизаций 
входа в программе Cubase физическим входам на IO 22. 

IO 22 Input Метки маршрутизации входа для моно 
треков в Cubase LE (при использова-
нии Lexicon® IO 22 Mono In шаблона 

проекта)
1 IO 22 In 1
2 IO 22 In 2
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Сведение аудио

Можно использовать функцию сведения аудио в Cubase LE для создания файла.wav из 
проекта Cubase. 

Этот.wav файл может быть прожжен на компакт-диске и воспроизведен с использова-
нием медиа плеера компьютера. Программа Cubase LE не выполняет сведение в фор-
мат mp3; однако, для сведения файла.wav в формат mp3 могут быть использованы дру-
гие программы.

Для сведения проекта, необходимо вначале установить левую и правую координатные 
точки. Один из способов – это нажатие клавиш [Ctrl] + [A] на клавиатуре компьютера 
и последующее нажатие клавиши [P]. Можно также щелкнуть клавишей мышки и пе-
ретащить любой из маркеров на нужную позицию.

После установки координатных точек, перейдите File > Export > Audio mixdown. Щел-
кните на кнопке “Choose” (Выбрать) и присвойте файлу имя в поле “File Name” (имя 
файла). Выберите место сохранения файла ‘wav в поле “Look in” и щелкните на кнопке 
“Save” (Сохранить). Файл вначале должен быть сохранен на жесткий диск компьютера. 
После этого может быть выполнен его прожиг на компакт-диске. 

Далее выберите Wave File (.wav) в поле ‘File Format’ (Формат файла), установите 
‘Sample Rate’ на 44.1 kHz, установите ‘Bit Depth’ на 16 bit, и нажмите Export.

Опции и основные функции в Cubase LE

В программе Cubase LE имеется много современных функций и опций для записи, ре-
дактирования и микширования. Для получения дополнительной информации, смо-
трите разделы «Начинаем» и «Руководство пользователя» в Cubase LE в разделе 
Help > Documentation

Использование Pantheon II Reverb в Cubase LE

Плагин Pantheon II reverb может быть установлен в Cubase LE двумя способами: как 
разрыв на аудиотреке или как разрыв на канале эффекта.

Для использования Pantheon как разрыва на аудиотреке:
1. Проверьте, что IO 22 включен и подключен к компьютеру (плагин Pantheon II ра-

ботает только при определении устройства IO 22).
2. Щелкните закладку Inserts для канала, в разрыв которого хотите включить плагин. 

Pantheon II reverb.
3. Щелкните пустой слот и выберите Earlier VST Plug-ins > Lexicon > Pantheon II. 

Вы будете слышать плагин Pantheon II reverb только на том аудиотреке, в разрыв ко-
торого он был включен.

Для использования Pantheon как разрыва на канале эффекта:
1. Проверьте, что IO 22 включен и подключен к компьютеру (плагин Pantheon II ра-

ботает только при определении устройства IO 22).
2. Добавьте канал эффекта (FX) Для этого перейдите Project > Add track > FX 

Channel, затем щелкните на закладке Inserts для канала FX.
3. Щелкните пустой слот и выберите Earlier VST Plug-ins > Lexicon > Pantheon II.
4. Щелкните на закладке Sends для любого аудио трека, который будет обрабатывать-

ся реверберацией.
5. Щелкните на пустом слоте и установите выход на FX-1 Pantheon II.
6. Щелкните на кнопке Power и установите уровень посыла на нужную позицию. На 

канал FX может посылаться сигнал с любого количества аудиотреков.
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Микрофонный вход Female XLR контакт 2 горячий
Импеданс входа: 3 кОм Балансный 
Фантомное питание + 48 В
Максимальное усиление +58 дБ
E.I.N. (при максимальном усилении): -125 dBu @ 58 дБ типичное усиление (150 Ом источник)

-129 dBu @ 58 дБ типичное усиление А-взвешенный (150 Ом источник)
Максимальный уровень входного сигнала: +21 dBu при минимальном усилении
Частотная характеристика +0/-1 дБ, 20 Гц до 20 кГц
THD+N: <0.006%, 20 Гц - 20 кГц (микрофонный вход на основной выход) уровень входного сигнала 0 dBu 

<0.003%, 1 кГц, +5 dBu уровня входного сигнала

Линейный вход 1/4” TRS балансный или небалансный
Импеданс входа: 20 кОм балансный, 13 кОм небалансный 
Максимальный уровень входного сигнала: +32 dBu
Частотная характеристика +0/-1,5 дБ, 20 Гц до 20 кГц (Опорная частота 1 кГц)
THD+N: <0.004%, 20 Гц - 20 кГц (линейный вход на основной выход) уровень входного сигнала 0 dBu 

Инструментальный вход TS 1/4” небалансный
Импеданс входа: 1 мОм
Максимальный уровень входного сигнала: +13 dBu
Частотная характеристика +0/-2 дБ, 20 Гц - 20 кГц (инструментальный вход на основной выход)
THD+N: <0.004%, 20 Гц - 20 кГц, уровень входного сигнала 0 dBu 

Линейный выход 1/4” TRS балансный или небалансный
Уровень >+18 dBu максимум
Импеданс 32 кОм балансный, 16 кОм небалансный 

Выход наушников 1/4” стерео джек 350 мВт на канал при 50 кОм

MIDI интерфейс 5 контактные DIN-разъемы для MIDI in и MIDI out (сигнал 5 вольт)

Частота дискретизации 44.1, 48, 88.2, или 96 кГц (определяется компьютерным приложением)

Динамический диапазон: A/D (24 Bit) 105 dB типично, A-взвешенный, 20 Гц - 20 кГц (44.1 кГц частота дискретизации)
D/A (24 Bit) 107 dB типично, A-взвешенный, 20 Гц - 20 кГц
A/D/A (24 Bit) 102 dB типично, A-взвешенный, 20 Гц - 20 кГц

Требования по питанию Важное примечание 
Имеется две различные модели IO 22. Перед началом работы проверьте соответствие требований по питанию.

~ 9 В 1.3 A 12 Вт*
Адаптеры питания, допустимые для:
Япония  ~ 100 В, 50/60 Гц Адаптер: PS0913B - 100*
США и Канада ~ 120 В, 60 Гц Адаптер: PS0913B - 120*
Европа  ~ 230 В, 50 Гц Адаптер: PS0913B - 230*
UK:  ~ 240 В, 50 Гц Адаптер: PS0913B - 240*
Австралия  ~ 240 В, 50 Гц Адаптер: PS0913B - 240-AU*

= 9 В 1.3 A 12 Вт*
Адаптеры питания, допустимые для:
US, Canada, Europe, Japan: ~ 100-240 В, 50/60 Гц Адаптер: PS0913DC-01*
Australia & UK: ~ 100-240 В, 50/60 Гц Адаптер: PS0913DC-02*

Размеры (мм) 304,8 (Ш) x 101,6 (В) x 95,25 (Д) 
Вес: 1,066 кг.

Инженеры компании Lexicon постоянно работают над улучшением качества продукции. Производитель остав-
ляет за собой право на внесение изменений в дизайн и технические характеристики устройства без предвари-
тельного уведомления.

Технические характеристики
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